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Introduction

This booklet intends to provide the necessary information on how to produce a digital catalogue describing paper documents based on reproductions of the internal paper structure. Chemical and mechanical aspects of the paper are not covered. The methods presented here can be applied to papers of various sorts and origins, although the booklet emphasizes cataloguing of medieval Middle Eastern handwritten documents.
1. What is paper, why & how to analyze it?

1.1 How paper is made: 
<image of papermakers xylo>
<image of mould, EU, OR>
When producing handmade paper, vegetable pulp is made to cover a screen fashioned with wires, threads or stems through which excess water can drip. Developments in the techniques employed in pulp and mould production, regional particularities, as well as the natural wear of the mould itself, are responsible for the features characterizing paper. 

The structure of paper, which can be seen when holding a sheet against a light source, is offering valuable clues as to the origin of a particular paper.
The pulp - Hemp and linen rags from old clothing, but also mulberry, bast, fishnets and bamboo fibres, were used as raw materials for producing paper pulp. The rags were bought from rag collectors, separated, washed, thumped or milled, suspended and floated in a slurry, which was in a large vat or in a water hole. Arabian paper makers mainly used mortars, teeter-totter stampers or flour mill stones for milling the hemp. The usage of these particular instruments caused an incomplete milling of the pulp, whereby rests of fibres are viewable. 
The mould – A wire screen mould with a wooden frame is used to scoop some of the slurry out of the vat. The imprint of the screen on the paper displays “laid lines”, dense lines which would run parallel to the longer side of the mould as hold by the papermaker, and “chain lines”, vertical and more spaced. “Watermarks” are created with wires saw to the screen and bend into shapes of various animated beings, objects or symbols, serving as trade marks. Watermarks are practically unknown in non-European papers. They were an Italian invention of the 13th century, like the use of metallic wires for the mould, which replaced the bamboo, reed or straw of Far Eastern and Middle Eastern papermakers.

The scoop - The slurry in the screen mould is artfully sloshed around the mould until it forms an over-all thin coating. The fibres are allowed to settle and the water to run out. When the fibres have stabilized in place but are still wet, they are turned out onto a felt sheet. Layers of paper and felt were built up in a pile and a weight is placed on top to press out water and keep the paper fibres flat and tight.
Drying and coating – While the above paragraph presents the traditional European way to make paper, elsewhere the mould could be left in the sun until the paper dried, or the wet paper pressed from the mould onto a wall, from which it felt by itself when dry. After that the surface of the paper was starched with paste and smoothed to get a writing surface on which the pen could glide with ease. 
1.2 Historical variations in paper making

There is a great deal of variation in the way paper was produced and used during its history. For scholars it is important to know these differences in order to appreciate the specificities of a particular paper and its cultural environment and their relation to other papers and environments. Catalogers too need to be aware of the history of the papers they are about to catalog, so that they can make the right choices while selecting, processing and presenting the material for public usage.

Historical awareness is particularly important in the case of Middle Eastern paper catalogs, since they describe different kinds of paper from those which dominate the market today.
To provide the reader with a sense of the heterogeneity characterizing the history of paper before the modern times, some essential highlights are given hereafter.
1. Paper samples
The reader will also find in this document a selection of papers, reproduced with various techniques, as a physical mean to experience the resulting differences in the end products as influenced by various factors.

1. Middle Eastern paper, late 12th c., Persia (document dated from 1199, Austrian National Library, Cod. mixt. ***, fol. ***) – Betaradiography
2. Middle Eastern paper, late 15th c., Egypt (Austrian National Library, Cod. mixt. 1420, fol. 5) – betaradiography
3. Far Eastern handmade paper, 21th c., Java – white halogen lamp

4. Idem supra – white light sheet

5. Idem supra – rubbing

6. European machine paper, 19th c. (paper mill unknown) – white halogen lamp

7. Idem supra – white light sheet

8. Idem supra – rubbing

9. European machine paper, 21th c. (Conqueror paper mills, 100 gr) – betaradiography

10. Idem supra – white halogen lamp

11. Idem supra – white light sheet

12. Idem supra – rubbing

13. European handmade paper, 21th c., Austria (*** paper mill) – betaradiography

14. Idem supra – white halogen lamp

15. Idem supra – white light sheet

16. Idem supra – rubbing

17. European handmade art paper, 21th c., Austria (*** paper mill) – betaradiography

18. Idem supra – white halogen lamp

19. Idem supra – white light sheet

20. Idem supra – rubbing

2. Spatio-temporal evolution

<isochron map>
This map shows the dates at which paper mills were attested in different parts of the Old World. The color shades give the time elapses since year 1 CE. It becomes visible that the paper making technology traveled and was adopted at different speeds.

<imposition graph>
This graph is representative for the replacement rate of parchment and papyrus by paper during the Middle Ages. The available data shows that it took paper at most two centuries to become the common writing support.

3. Variation in production materials

<img raw materials>
Paper can be made out of different raw materials, mostly organic (bark, cotton…), but also processed (rags…). The choice initially depends on geographical considerates, from which emerged regional traditions.
4. Differences in hardware and production methods

<images: floating mould, fixed mould, infinite band>
Technological differences in paper manufacturing was another factor leading to regional differentiation. For example moulds without a rigid frame were prevalent in China, while Europe used exclusively rigid moulds. Producing paper of arbitrary length on a rotating band rather than finite length paper in individual moulds was an invention of the industrial era (France, 1798).

<images: drying on walls, in barns, on mould>
Drying could be done by leaving the wet paper paste on the mould, by plating it on a wall in the sun, by hanging it on beams or by directing hot air over it.
5. Natural impact on variations observed in paper making

<map: mill locations are along rivers>
Paper needs water to be manufactured: little for small scale production, much more for a solid business. So most paper mills using hydraulic energy for activating paper making machines are to be found near rivers.

Another natural factor: Quantity of produced paper depend on the both the availability of raw material as well as paper users. The plagues that decimated entire populations during the medieval times limited the amount of worn clothes that could be transformed into paper (clothes of dead people were burned) and the number of people using paper.
6. Technical impact

<CHI ISL EU paper smoothness and inscribing instruments>
Inscribing instruments varied across cultural areas and so did the requirements for specific paper qualities. Brushes were used in China were ink absorbing paper was technically and esthetically acceptable; in the Middle East the use of reed pens demanded smooth paper that doesn’t let the absorbed ink spread, so paper was coated; European paper adapted to the requirements of printing technology, making paper sturdier and coated (also, a thicker ink was used for print).
7. Cultural impact

<img: half moon wm>
European paper made for export to Islamic countries was specially designed to suit the target culture: Italian medieval paper makers designed watermarks with half moons for export to the Ottoman Empire, while local merchants sorted out papers showing watermarks with religious connotations such as crosses or the figure of the pope.

8. Regional highlights

For pre-modern times there are three principal paper making cultural areas, each with its specificities. China was the birthplace of papermaking and Chinese paper is usually uncoated and displays long fibers. The Islamic realm contributed to the passage from free to rigid frame moulds and rags as raw material. It also produced smoothly coated paper, which can be either thick (pre-1500) or fine (mainly Persian). Europe introduces the use of watermarks, the metal sieve and mechanized the process of paper making.

1.3 On Middle Eastern paper and paper studies

1. Significant Middle Eastern paper characteristics

1. Coating – Paper is coated so as not to let the ink spread in the paper pulp, which was esthetically unacceptable.
2. Smoothing – Paper is smooth in order not to hinder the movement of the reed pen.
3. Width – There are two cultural-technological periods roughly centered on the 15th century, paper becoming significantly finer after this period, a trend initiated in Persia.
4. European monopol – Local paper making traditions died out to the profit of imported European paper increasingly during the 16th century in the Ottoman Empire and the 17th century in Persia.
2. The importance of Middle Eastern paper studies
The use of paper had a significant impact on the evolution of the Islamic societies in many realms that lead to an increase of dynamism in this civilization from its early days on. As such paper deserved to be studied.
Probably the most important impact was that paper facilitated the flow of information inside a population, being a relatively cheap product. This boosted literacy rates (arguably higher in medieval Islamic countries than in European ones), provided the basis for a solid bureaucracy (more documents can be produced and archived), facilitated economical transactions (use of letters of credit are seen as the Islamic roots of capitalism), sustained the spread of religion (availability of the Qur’an) and cartography (and its influence on trade and warfare), became the medium of the principal artistic expression forms in Islam: literature and the visual arts of the book.
From a civilizational point of view knowledge of Middle Eastern paper is also important for being the source of European papermaking. Technologically it is distinct from both Chinese and European traditions, thus requiring an approach in its own.
3. State of the art

There is extremely little database material on Middle Eastern paper available, most not in digital format. Analysis methods are not customized. There are few scholarly studies and almost no known medieval written sources. The subject is open for pioneering research.
4. Needs and developments axes
1. Data gathering – The production of online paper databases of physical aspects of Middle Eastern papers is indispensable to the development of knowledge on this topic. Progress cannot be expected without the availability of extensive and objective data and processing methods.

2. Data evaluation – With the increased availability of data more and more studies on technical and cultural aspects of Middle Eastern papers can be produced. An essential tool is an atlas of paper characteristics in Islamic countries. Other fruitful study axes are the paper trade between Europe and the Middle East and the exploration of the shift occurred around the 15th century in Middle Eastern paper quality.
3. Popularization – Exhibitions on Middle Eastern paper can bring the interest in this topic to the common public in support to scholarly activities.
4. Revival – Middle Eastern paper is knowledge extinct since several centuries. It is however part of the identity of Islamic cultures. As such – and given the contemporary interest for the arts of the book – wouldn’t it be worth reviving this craft? It could provide strong motivation to many workshops of traditional arts and crafts across the Islamic world. Traditional papermaking could become a popular activity along calligraphy, miniature painting, bookbinding and marbling, which are thriving everywhere in the Middle East.
1.4 Usefulness of paper studies

Papers of historical and modern documents are studied for expertise and history by a wide range of users.
1. Expertise – Paper expertise consists in identification of documents based on information provided by the paper (such as date of the writing of an manuscript based on the date of production of the paper on which it was written), authentication of a document of questioned identity based on a securely identified document (a document written on a paper never used by a given writer has a high probability of being a fake), and measurement of various features in order to characterize the paper.
2. History – The history of paper can be conducted as part of the history of science and technology (ex.: evolution of raw paper materials and processing methods), as economical history (ex.: variation in paper prices), as an aspect of international relations (ex.: import-export between Europe and the Middle East), it can enhance the understanding of social structures (ex.: customs of papermakers) or culture (ex.: symbolical choices of watermark choices), etc.
3. Users – Most usually the scholars in humanities conducting historical research on papers are paper historians, book historians, art historians or archivists. Paper studies are valuable also for the cultural heritage area, with library, archive and museums conservators, private collectors and art dealers participating. The interest in technical aspects of paper expertise characterize the paper-related work for law enforcement as done by forensic experts, the police and intelligence agencies. A certain degree of interest in paper studies is also exhibited in manufacturing, by artisanal and industrial papermakers.
1.5 Paper analysis methods

1. Written & oral sources – These sources can provide information about the technology and materials used to produce papers, as well as economic and other cultural factor influencing the production of paper.

2. Chemistry – Chemical and DNA analysis can be used to analyze papers. Some of the principal aspects to look at and what information they yield are:
– identifying plants from fiber types in paper can lead to localize where a paper document was produced and provide data for history of technology
– the length of fiber is an indicator for the production process and the quality of papers (fine paper has usually shorter fibers)
– if data on the water, additive substances and coating substances used in the paper pulp and coating can be extracted then this might lead to location identification, information about the production process and help the history of technology
3. Mechanical analysis – Most of this type of data helps the expertise of paper documents (identification and authentification), the establishment of atlases of paper types and the history of technology. Main data is:
– width

– roughness

– weight

– bending
– coating

– color

4. Structural imaging – 
1. What is analyzed
The preferred analysis features, material unhomogeneities in paper, are important information sources about it’s history. They are due principally to the paper paste and the imprint left by the mould on the wet paper paste in the early stages of the paper making process. Watermarks are for those paper cultures where they are used the foremost expertise feature. Structural features become visible when imagined with various techniques and these images can be evaluated by the naked eye and measured with analog or digital tools. It is on the production of such images that this document is focusing.

List of structural paper features and possible measurements
1. Mould imprint features


1. Sieve imprint

1. Lines

1. Laid lines (mean density, other statistics (range, standard deviation, skew, kurtosis), wire width to space in between lines ratio (mean, variation statistics), straightness (global, of each line), pattern of movement of the wires of the mould over time)

2. Chain lines (mean distance between chain lines, other statistics, pattern type, mean distance per pattern, orientation, straightness (global, of each line))
2. Watermarks

1. Watermarks (presence, motif, components, location, landmarks along the contour)
2. Countermarks (number, location, landmarks)

3. Zigzag wires (presence, shape, location, landmarks)



3. ‘Wire’ (for each feature (lines, watermarks and thread): mean width, width statistics)



4. Sewing thread

1. Thread on chain lines (shape, landmarks)

2. Thread on ribs (shape, landmarks)

3. Thread on watermarks (existence, location)

2. Mould imprint

1. Ribs (number, location, width, location)

2. Paper pulp traces
1. Paper pulp distribution (density variation)

2. Paper fibers (lengths variation, distribution)

3. Paper sheet width (mean, other statistics)

4. Faults in paper (location, size, type)
<img with elements location>
2. Imaging and measurements methods
<img> diff.
<table pro & cons> 
Paper Reproduction Methods - Pros and Cons

  
Tracing 
Rubbing 
Backlight 
Backlight-frontlight subtraction 
Ultraviolet 
Indirect ultraviolet (Dylux) 
Infrared 
X-Ray 
Betaradiography 
Surface laser scan

Reproduction quality 
low 
good 
good 
good 
good 
? 
? 
excellent 
excellent 
good

Equipment 
minimal 
minimal 
simple 
simple 
simple 
? 
simple 
specialized 
specialized 
specialized

Costs 
minimal 
minimal 
low 
low 
moderate 
moderate 
moderate 
high 
high 
high

Health risks 
none

(although Briquet went blind copying watermarks) 
none 
none 
none 
moderate 
moderate 
moderate 
radiation hazards 
radiation hazards 
moderate

Conservation issues 
- none

(in the reproduction and document are side by side)

- moderate

(if the tracing paper is on top of the original document and if this is fragile) 
moderate

(contact between reproduction and document paper) 
moderate

(document needs to be firmly fixed for reproduction) 
moderate

(document needs to be firmly fixed for reproduction) 
moderate

(document needs to be firmly fixed for reproduction) 
moderate

(document needs to be firmly fixed for reproduction) 
moderate

(document needs to be firmly fixed for reproduction) 
low 
low 
moderate

(document needs to be firmly fixed for reproduction)

Library permission 
- none for side-by-side reproduction

- difficult for contact tracing 
difficult 
difficult 
difficult 
difficult 
difficult 
difficult 
extremely difficult

(plus transportation permits needed for the radioactive plate) 
extremely difficult

(plus transportation permits needed for the radioactive plate) 
difficult

Other positive aspects 
  
- objective reproduction of the sieve imprint 
  
  
  
  
  
  
  
 

Other negative aspects 
- reproduction is a subjective interpretation of the original

- image of a watermark may be the result of two or three folios within a manuscript or document [ please clarify this ] 
  
- to restaure aspect ratio, needs image registration 
- to restaure aspect ratio, needs image registration 
  
  
  
  
  
- bulky hardware

- takes too much time for imaging in the present state of the technology

http://www.bernstein.oeaw.ac.at/twiki/bin/view/Handbook/HandbookReproProsCons
<img AD751 vignette>
AD751 is a software by Vlad Atanasiu specifically designed for the measurement of laid lines densities (described later on in this document). To the authors knowledge there are no other off-the-shelf software for automated processing and measuring of structural paper features. A useful software for various basic tasks of paper imaging and cataloging is Photoshop and similar image processing software. See for additional suggestions http://www.bernstein.oeaw.ac.at/twiki/bin/view/ Main/ImageProcessing.
3. Issues in structural imaging
Physical issues – During the paper manufacturing process both the sieve and the paper paste undergo minute distortions. This is why no two papers will be structurally identical, something that has to be taken into consideration when evaluating papers. Furthermore, variations in air humidity as well as mechanical tear and wear can affect paper and introduce differences in images of the same paper.
Human factors – Recording paper features by freehand tracing produces too subjective results to be a reliable reproduction technique. There are a number of other cheap and simple to use methods available and tracing should be avoided.

Technical issues – Different imaging techniques have different reproduction qualities, as well as recoding sometimes different aspects of the paper structure. The different ways in which features can be measured and how images are postprocessed in image processing software also are sources of variation.
While the issues mentioned above might introduce too small variations, the cataloger has to be aware of them and document the choices for the benefit of the users.

1.6 Workflow for producing a paper catalog

1. Workflow

Following is a list of steps for the production of a catalog of papers. Most of these steps are detailed further on in this document.
<diagram workflow>
<persons workflow>
1. Protocol – A protocol on how the catalog came to be is to be kept and provided as documentation alongside the database. Information might include cultural, managerial and technical data: for what reason it was decided to produce the catalog, who where the initiators and participants, why certains decissions were taken in regard to manuscript selection, choice of working methods, details about the reproduction camera, image format, database structure and software, etc.

2. Team – While it is possible for one single person to do the entire cataloging by herself, it is more efficient to divide the task among several individuals.
1. Project manager – Supervises the work of the team.

2. Codicologist – Identifies the collection, manuscripts and folios to be reproduced; describes paper features (those not measurable by dedicated machinery); writes a historical description of the data.
3. Reproduction technicians – Produce digital reproductions of the papers using various methods (backlight with incandescent light or light foil, rubbing).
4. Measurement technicians – Measures various image features using mechanical instruments and software (paper width, laid lines density...).
5. Computer technicians – Sets up the catalog database, provides software support to the other team members, writes a technical description of the digital catalog.
3. Collection selection – Selection of a collection of documents to be catalogued. The choice depends on factors such as:
1. available budget, time and workforce
2. the accessibility of the material to the cataloged (Does one have to travel to the conservation place of the documents? Is the conservation institution willing to allow reproduction and cataloguing?).
3. the historical value of the documents (Practical limitations make the choice of a specialized collection appealing for cataloging. In such a virgin field as paper studies choosing only documents identified by date, location or signature provides a reference basis for future expertise. One can also restrict cataloging to documents from a specific time period or geographical area.)
4. Manuscript selection – Selection of individual documents of the collection to be retained for cataloging. When not the entire collection is to be cataloged, a choice has to be made which particular documents are to be cataloged. Criteria are the value of the paper of these documents for paper studies, the content of the documents, their codicological and aesthetic characteristics, etc.
5. Folio selection – Selection of folio to be reproduced, in the case of multi-page documents. The base idea is to reproduce a representative number of papers in the document.
6. Quires description – Recording the quires structure.

7. Paper width – Recording the paper width of the folios to be reproduced.
8. Hardware and software acquisition – Selection and acquisition of reproduction hardware and software. The choice depends on the available budget and technologies, as well as on the goals of the catalog.
9. Imaging – Imaging a selection of paper structures.
10. Metadata – Adding metadata to the images.
11. Postprocessing – Postprocessing images: contrast enhancement, registration, ink suppression...
12. Image measurements – Measuring specific features in the images.
13. Database – Populating the database with the images and the metadata.
14. Archival – Packaging a copy of the database for long term archiving.
15. Publication – Publishing the database online, off-line or/and in print.
2. Checklist of materials needed for a digital paper catalog
Rubbing
[ ] coal pen

[ ] fine paper

[ ] plastic sheet
Backlight reproduction

[ ] computer
[ ] digital camera (supporting tif, raw formats)

[ ] 2 × 5 multi-steckdose

[ ] 2 × 5 m kabelverlangerung

[ ] fernauslöser

[ ] trepied

[ ] light source

[ ] light diffusor

[ ] lampe UV

[ ] 2 black velvet

[ ] 35 Klemmen

[ ] pointer to keep pages flat

[ ] massstab

[ ] ms Stand

[ ] 15 gants

[ ] transport sack

[ ] alarme anti-vol

undecided:

[ ] 200W lamps

[ ] reprodcution Gerüst

[ ] bandes transparentes

[ ] Xerox glass

[ ] mire

3. Cataloging effort example

This gives an estimate of the effort involved to produce a catalogue of papers from 600 documents (the equivalent of Qur’ans in the National Library of Egypt).

Selection of 600 documents from a collection > 1 week
Selection of pages for reproduction > 20 min / document

Imaging > 10 min / document

Metadata to images > 20 minutes

Metadata to document > 10 minutes

Database maintenance > 2 weeks
1 h / 1 document

6 h / day > 6 document

20 days / month > 120 documents / month

5 month / 600 documents / 1 person

2,5 month / 600 documents / 2 person

2. Reproduction 1: Paper selection and reproduction hardware

2.1 Identifying quires
1. Definition – Similar to a printed book, a manuscript is made from folded sheets of paper grouped together in so-called quires, themselves sewn into the binding cover. In case the information on the structure of the quires is not provided in the codicological part of the documents catalog, it is advisable to take the necessary time and describe it while recording other aspects of the paper.

2. Importance – Information on quires structure helps expertise documents, being a criterion for regional and temporal classification (since quire structure varies); it also provides a mean to understand how the production of books was managed, by possibly replying to questions such as how many scribes were collaborating on a manuscript or how diversified was the paper supply in a given town. Secondarily, the quires structure might reveal missing, added or replaced parts of a document.
3. Physical quire identification – Counting how many folded paper sheets – bi-folios – compose one quire can be started by looking for the sewing thread of the binding inside the folds, which becomes visible in the middle of a quire. We can mark the place with a paper slip since the middle bi-folios are later to be reproduced photographically. Then we find out how many paper sheets belong to the same quire on each side of the quire middle. Looking at the folding of the paper edges on the document’s bottom edge might be helpful.
While most quires are made from stacks of folded sheets, in some cases a folio might have been removed, leaving only a stub close to the quire fold. Or tear and wear might have separated a bi-folio along the fold in two free folios. These particular cases have to be duly recorded.
4. Recording quire structures – We mark the quire structure by writing top to down the folio number in the first half of a quire, next to which are written the folio numbers marked on the second half of each folded sheet. For a loose sheet nothing is written opposing to its folio number. We write down the folio numbers exactly as they appear on the manuscript, i.e. disregarding possible misfoliotation. In case several foliotations appear on the document, we choose one of them and record in the catalog protocol which one it is. Example:


9

1
6

2
7


5

4
5

The above notation reads as ‘one quire, with two folio missing (opposite folio 9 and 5) and following folio pairs: 1-6, 2-7, 4-5; misfoliated’. It is advisable to note down the structure directly on a computer (Notepad, Excel) instead of on a sheet of paper.
2.2 Selecting remarkable papers for reproduction
As noted before, the paper reproductions made from a document should strive to be representative of the totality of papers present in the given document. Here are given a number of guidelines for achieving this goal.
1. Middle bi-folio – The innermost sheet of each quire (2 folios) is reproduced. This provides paper samples evenly spaced over the whole manuscript. The method should be followed even if apparently the same type of paper is used for the entire document.

2. Watermarks – Each different watermark type is reproduced. This increase the quality of paper expertise.

3. Extraordinary folios – If a folio looks sufficiently different from those already selected, it should be reproduced. The differentiating factors are mentioned above, in the section 1.5.4 ‘List of structural paper features and possible measurements’.
2.3 Paper rubbings reproductions

Rubbing consists in putting a very fine paper over the document to be reproduced, a rigid plastic sheet underneath and gently rubbing a soft pencil over its entire surface – the imprint of the mould on the paper will appear.

<img> rubbing
http://watermark.kb.nl/reproduction.html

2.4 Preparing a manuscript for backlight reproduction
Following is presented a suggestion for the setup needed for backlight paper imaging using the hardware mentioned in the preceding chapters. It is intended for use there where the facilities of a professional reproduction laboratory are not available.

Preparation of the registration marks

Because the paper to reproduce is not parallel with the surface of the camera’s digital recording element, and because the camera’s objective itself might induce distortions, it is necessary to correct the reproductions, a process called ‘registration’. 
1. Procure four L- or X-shaped, non-transparent, items which will serve as markers. You can make them yourself by cutting a cardboard or a fine metal sheet.

2. Cut a square from a paper with sides slightly inferior to the smaller side of the document to be imagined (to avoid markers in the middle of the image; registration is better when markers are farther apart).
3. Put the square paper on the setup’s plexiglass with sides parallel to the document (to avoid a registered but skewed document).

4. Fit a marker around a corner of the square and attach it with a transparent tape without taping the paper square (an L- or X-shaped marker has a corner, making it easy to fit to the square paper).

5. Repeat with the remaining markers.

6. When the image that was taken of the marked paper is to be processed, registration can done automatically by using image processing software (in Photoshop see Selection > Transformation > Torsion). The steps involved consist in locating center of the markers (their shape is know and identical across reproduction images, their grayscale value is 0 due to the markers opaqueness) and registering the image (knowing that the markers outline a square).

7. A centimeter has also to be taped to the plexiglass to give the scale of the reproduction. The centimeter can be made from transparent plastic or from incised cardboard or metal for better visibility. <img>
Document setup and imaging

1. A black non-reflecting textile is spread over the reproduction table. This gives the images a neutral frame around the actual paper reproduction and avoids the influence of the paper’s color spectrum by the background.

2. Adjust the markers position to fit the size of the paper to reproduce.
3. The document is laid open on the table. If there is no danger to damage the spine, the document can be opened at 180° - the reproduction will capture the entirety of the page. Otherwise supports are inserted under each document’s side. If less than around 70% of the page can be imagined, then a light sheet should be used. In this case the document is opened at 90°, one side flat on the table, the other kept vertical by a support.
4. The page to be imagined is raised to the vertical, and a L-shaped plexiglass, size bigger than that of the paper, is positioned in front of it and another behind.
5. In case the plexiglass’ are not in a stable position they can be hold together with two clamps on their sides.
6. An image of the paper is taken with the camera in tif or raw format, using a remote control or the camera timer to avoid shaken shots. 
7. The plexiglass is carefully removed from the imagined paper and mounted around the next paper to be imagined, where the procedure starts anew.
3. Reproduction 2: Physical measurements and image management
3.1 Paper width measurement 
/.../
3.2 Metadata for the images 
- list of data fields (short, extended)


- felt side


- existence of countermarks


- measurments metadata



- LL%



- CL spacing pattern

- input DIY:


- process for img files & data


- material
4. Post-processing, analysis, online databases and perspectives 

4.1 Elements of image post-processing
Image registration – /…/
Contrast enhancing – It is useful to enhance the contrast of images before publication so that the imprint of the mould becomes clearer to the human eye. This is basic function found in most image processing software. In Photoshop one selects from the menu Image > Adjustments > Automatic levels. The procedure can be applied automatically on a batch of images by recording the steps (Window > Scripts > New Script > Record), generating a Photoshop script (File > Automation > Create a droplet) and drag-and-dropping the images on the script file.
<img original / contrast enchanced>
Images for print – The quality of paper reproductions printed on paper might be enhanced if the mould imprint is further emphasized. This can be done with the BlueNile software, which supports also contrast enhancing (see references in the documentation section). It should be noted that a too strong imprint enhancement can lead to undesired distortions of the imprint pattern.
<img original / imprint enchanced / excessive enchancement>
4.2 Analyzing paper structures

Laid lines density can be automatically measured using the AD751 software (see references in the documentation section). The use of a software algorithm instead of manual measurement has following advantages:
– objective measurement

– stability in measurement quality over time

– measurements are performed at multiple locations across the paper

– rapidity of measurement

<AD751 screenshots>
4.3 Introduction to online database
The Bernstein Consortium (http://www.bernstein.oeaw.ac.at) is working to develop an Open Source database software adapted to the needs of cataloging papers. Here are some suggestions to developers of ad-hoc databases stemmed from the experience of the Consortium in integrating the foremost online databases on paper.
Integration capability – A significant impact on the knowledge on papers comes from the integration of individual databases and they should be designed from the beginning with integration in mind. This implies that the developers study the existing databases, use similar description fields, and adopt compatible formats and common metadata vocabularies. Particular care has to be given to the description of watermarks. Check the Bernstein Consortium’s website for technical documentation.
<screenshots of Bernstein databases>
Statistical feature – While the online databases in Humanities and cultural heritage are ever increasing, most are designed for the view of single items at any one given time in mind, few providing statistical tools to grasp the characteristics of the whole data population or subgroups thereof. Because paper expertise is based on measurements, it is essential to a quality paper database to have statistical functionalities. Since only a limited number of functions can be embedded, researchers should be allowed to download data chunks for further analysis.
Documentation – Good documentation is sine qua non to integration and necessary to research too. The process of imaging and cataloguing should be recorded and metadata consistently applied and described.
4.4 Documentation
Here is a concise list of references that might be of particular help to a cataloguer of paper documents, especially Middle Eastern documents.

1. Books
History and techniques of papermaking –

Dard Hunter, Papermaking: the history and technique of an ancient craft, New York, Knopf, 1978.
http://www.amazon.com/Papermaking-Dover-Lettering-Graphic-Printing/dp/0486236196/ref=pd_bbs_sr_1/104-7395674-4688715?ie=UTF8&s=books&qid=1182274105&sr=8-1
Codicology manual for Middle Eastern manuscripts –

François Déroche, Islamic codicology: An introduction to the study of manuscripts in Arabic script, London, Al-Furqan Islamic Heritage Foundation, 2005. (Arabic version by Ayman Fu’ad Sayyid)
Terminology of Middle Eastern manuscripts –

Adam Gacek, The Arabic Manuscript Tradition. A Glossary of Technical Terms and Bibliography, Leiden, Brill, 2001.

http://www.amazon.com/Arabic-Manuscript-Tradition-Bibliography-Orientalistik/dp/9004120610/ref=sr_1_1/002-7133189-7111229?ie=UTF8&s=books&qid=1182335182&sr=8-1

Cultural history of Middle Eastern paper –

Jonathan Bloom, Paper Before Print: The History and Impact of Paper in the Islamic World, New York, Yale University Press, 2001.

http://www.amazon.com/Paper-Before-Print-History-Islamic/dp/0300089554/ref=pd_bbs_sr_1/104-7395674-4688715?ie=UTF8&s=books&qid=1182272073&sr=8-1
A genera-public history of papermaking –

Lucien Xavier Polastron, Le papier : 2000 ans d'histoire et de savoir-faire, Paris, Imprimérie nationale Éditions, 1999.
http://www.amazon.ca/exec/obidos/ASIN/2743303166/ref=nosim/addallbooksea-20
What quantitative paper history can achieve –

Ezio Ornato, Paola Busonero, Paola F. Munafò, M. S. Storace, La carta occidentale nel tardo Medio Evo. Aspetti qualitativi, tipologia, struttura delle forme [The occidental paper in the Late Middle Ages. Qualitative aspects, typology, mould structures], Rome, Instituto Centrale di Patologia del Libro, 2001.
http://www.libreriauniversitaria.it/BIT/8888298002/La_carta_occidentale_nel_tardo_Medioevo.htm
Example of cartography applied to paper studies –

Maria Zaar-Görgens, Champagne – Bar – Lothringen. Papierproduktion und Papierabsatz vom 14. bis zum Ende des 16. Jahrhunderts [Paper production and distribution from 14th to the end of the 16th century], Trier, Porta Alba, 2005.
http://www.amazon.de/Champagne-Lothringen-Papierproduktion-Papierabsatz-Jahrhunderts/dp/3933701112/ref=sr_1_1/303-6744679-6117843?ie=UTF8&s=books&qid=1182272247&sr=8-1
Includes collection of paper samples –

Bartholome Sulser, Materialkunde für Buchbinder [Instruction in materials for bookbinders], Zürich, Verlag L. Nabholz, 1927. (approx. 220 paper samples)
Silvie Turner, The book of fine paper: a worldwide guide to contemporary papers for art, design & decoration, London, Thames and

Hudson, 1998. (18 paper samples)

http://www.amazon.com/Book-Fine-Paper-Silvie-Turner/dp/0500018715/ref=sr_1_7/104-7395674-4688715?ie=UTF8&s=books&qid=1182290540&sr=8-7
Exhaustive paper studies bibliography – 

Frieder Schmidt, Elke Sobek, International Bibliography of Paper History, München, Saur, 2003.
Print: http://www.ddb.de/sammlungen/pdf/ibp.pdf
Online: through http://www.bernstein.oeaw.ac.at (available in 2009)
2. Websites

— Paper reproductions databases

Radiographies, rubbings samples – Watermarks in Incunabula printed in the Low Countries (WILC)
http://www.kb.nl/bc/incun/watermerken-en.html
Quire formula – Watermarks of the Middle-Ages (WZMA)

http://www.oeaw.ac.at/ksbm/wz/wzma2.htm
Watermarks motifs – Piccard-Online

http://www.landesarchiv-bw.de/piccard/
Middle Eastern papers – Kabikadj

http://web.mit.edu/atanasiu/www/KABIKADJ/INDEX.HTM
Further databases (add your own collection!)

http://www.bernstein.oeaw.ac.at/twiki/bin/view/Main/PaperDatabases

— Projects, Organizations

Database integration – Bernstein. Image based paper expertise and history
http://www.bernstein.oeaw.ac.at
Conference links – International Paper Historians Association (IPH)

http://www.paperhistory.org
— Image processing tools

Laid lines density measurement – AD751 (Vlad Atanasiu)
http://mywebpage.netscape.com/atanasiuvlad/ad751/index.html

Imprint structure enhancement – BlueNile (Vlad Atanasiu)

http://mywebpage.netscape.com/atanasiuvlad/bluenile/index.html

3. Hardware

Light sheets – Lightech (Bamberg, Germany)

http://www.lightec.com/e/leuchtfolien.html
Paper width measure tool – Series 293-151-30 IP 65 Digimatic Outside Micrometer with Data Output (Mitutoyo, Japan)
http://www2.mitutoyo.de/index.php?id=374&artikelnummer=293-151-30
